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1 Foreword English

INFORMATION
Date of last update: 2021-12-27
► Please read this document carefully before using the product and observe the safety

notices.
► Please contact the manufacturer if you have questions about the product or in case of prob­

lems.
► Report each serious incident related to the product to the manufacturer and to the relevant

authority in your country. This is particularly important when there is a decline in the health
state.

► Please keep this document for your records.
The "646C52=V1.2 PAULA 1.2" adjustment software is referred to simply as PAULA 1.2, soft­
ware, adjustment software or product below.
Only put the product into use in accordance with the information contained in the accompanying
documents supplied.

2 Product description
2.1 Function
The PAULA 1.2 software is used in combination with the 757M11=X-Change MyoBoy and sup­
ports the O&P professional in the myo-signal evaluation, product selection, socket design and the
ordering of components or complete test prostheses for upper limbs.
Communication between the software and the prosthesis takes place exclusively via the USB con­
nection of the 757M11=X-Change MyoBoy hardware.

2.1.1 PAULA 1.2 software functions
• Selection of components to create myoelectric, cable-controlled and passive arm prostheses
• Evaluation of muscle signals and optimal electrode adjustment
• Playful training of the musculature by means of an integrated computer game. Patients learn

quickly and effectively how to contract individual and specific muscle groups
• Video animations show how to measure correctly the limbs to be fitted
• The software suggests appropriate components based on the patient's information
• The product ensures the compatibility of the selected components throughout the entire pro­

cess.
• Integrated free-space computations, indicator to help avoid excessive prosthesis lengths
• Realistic simulation of all current MyoBock systems
• Residual limb measurement/documentation via photo camera
• Computer-aided design (CAD) of test sockets
• Electronic ordering of fully prefabricated Ottobock test sockets or individual Ottobock com­

ponents
• Documentation of all recorded patient data with printouts, e.g. for the sponsor
• Integrated online help to support the O&P professional's work

3 Intended use
3.1 Indications for use
PAULA 1.2 software is intended exclusively for prosthetic fittings of the upper limb with myoelec­
tric Ottobock components. 
PAULA 1.2 software can be used for unilateral or bilateral amputees or in case of dysmelia.

3.2 Conditions of use
• For the software to be able to be used, the PC must fulfil the system requirements.

2



3

• The battery of the prosthesis must be charged.

3.3 Contraindications
• All conditions which contradict or go beyond the specifications listed in the section on

"Safety" and "Indications for use". 

3.4 Qualification
The adjustment software may only be used by qualified personnel that has participated in the rel­
evant product training and has been certified for the application. Additional product training
courses may become necessary to qualify for software updates.

4 Safety
4.1 Explanation of warning symbols

CAUTION Caution indicates a hazardous situation which, if not avoided, could result in
minor or moderate injury.

NOTICE Warning regarding possible technical damage.

4.2 Structure of the safety instructions

CAUTION
The heading describes the source and/or the type of hazard
The introduction describes the consequences in case of failure to observe the safety instruc­
tions. Consequences are presented as follows if more than one consequence is possible:
> E.g.: Consequence 1 in case of failure to observe the hazard
> E.g.: Consequence 2 in case of failure to observe the hazard
► This symbol identifies activities/actions that must be observed/carried out in order to avert

the hazard.

4.3 General safety instructions

CAUTION
Non-observance of safety instructions
Personal injury/damage to the product due to using the product in certain situations.
► Observe the safety instructions and the stated precautions in this accompanying document.

CAUTION
Operator errors during the adjustment procedure
Injury due to unexpected prosthesis behaviour.
► Do not charge the prosthesis battery during the configuration process since the prosthesis

is not functional while the battery is being charged.
► The prosthesis must not remain unattended during the configuration process while connec­

ted to the adjustment software and being worn by the patient.
► Take note of the maximum range of the Bluetooth connection and note that obstacles may

limit this range.
► During the data transfer (PC to prosthesis), the prosthesis wearer should remain sitting still

and the BionicLink PC must not be removed from the computer.
► Inform the patient immediately if the data connection is accidentally interrupted during the

configuration process.
► The connection to the prosthesis must always be disconnected after adjustments have been

completed.
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► Ottobock product training for the prosthesis must be completed before the first fitting. Addi­
tional product training may be required in order to qualify for product updates.

► Use the online help which is integrated into the software.
► Do not share your unlock PIN.

INFORMATION
► Please note that observing the prescribed system requirements is mandatory.
► It is recommended that you do not run any other programs during installation and use of the

adjustment software, since this can affect performance.
► If you require further information, contact the Ottobock office responsible for your country.

INFORMATION
Cybersecurity
► Keep your operating system up to date and always install any available security updates. 
► Protect your computer from unauthorised access (e.g., by using virus scans, password pro­

tection etc.). 
► Do not use unsecured networks.
► Please contact the manufacturer if you suspect cybersecurity problems.

5 Scope of delivery
• 1 pc. "646C52=V1.2 PAULA 1.2" software CD
• 1 pc. Instructions for use (qualified personnel) 

6 System Requirements

INFORMATION
Operating PAULA 1.2 and 757M11=X-Change MyoBoy can only be ensured if the USB driver
has been installed and the MyoBoy connected to the PC. The USB driver of the MyoBoy must
not be installed while the PAULA 1.2 software is running. For more information on the
757M11=X-Change MyoBoy, see the relevant instructions for use.

6.1 General information
• Important data should be backed up before installing the program.
• In most cases, a charger connected to a laptop interferes with the operation of the electrodes;

that is, the values do not reach zero even when the electrodes are not activated. Therefore,
disconnecting the charger and operating the laptop on battery power while recording myo
data is recommended. 

6.2 Minimum PC hardware requirements
The minimum hardware requirements depend on the operating system. The following require­
ments apply if they are higher:
For 32-bit platforms
• PC with an Intel Pentium IV processor
• 1 GB RAM
• At least 1.5 GB free hard drive space
• Graphics card with Open GL support
• Resolution 1024 x 768
• Display scale 100% or 96 DPI (higher settings can lead to display problems, depending on

the resolution selected)
• 32-bit colour depth (16.7 million colours)
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• CD-ROM drive or DVD-ROM drive
• 1 free USB connection 2.0 or higher
• Mouse and keyboard
For 64-bit platforms
• PC with an Intel Core2 processor (x64) or faster
• 2 GB RAM
• At least 1.5 GB free hard drive space
• Graphics card with Open GL support
• Resolution 1024 x 768
• Display scale 100% or 96 DPI (higher settings can lead to display problems, depending on

the resolution selected)
• 32-bit colour depth (16.7 million colours)
• CD-ROM drive or DVD-ROM drive
• 1 free USB connection 2.0 or higher
• Mouse and keyboard

6.3 Supported operating systems
The following operating systems (32-bit and 64-bit) are supported:
• Microsoft Windows 7, SP1 or higher, all editions except Microsoft Windows 7 Starter
• Microsoft Windows 8
• Microsoft Windows 10

INFORMATION
Please note that the latest USB driver version must always be installed to connect to the
757M11=X-Change MyoBoy. You can download the latest driver version from the following site:
http://ottobock.com/en/datastation. The latest version can also be downloaded via the "software
update" function (see page 8).

6.4 Additional Recommended Software Components
The following software components are recommended:
• Internet browser
• An installed program for sending e-mail (e.g. Microsoft Outlook, Mozilla Thunderbird...).

6.5 Additional Installed Software Components
The following additional software components are required and installed during installation of the
software (if they are not already installed on the PC):
• Microsoft .NET Framework 3.5 (must be downloaded for Windows 8 & 10 at

http://ottobock.com/windows8)
• Microsoft .NET Framework 4.5.2

INFORMATION
Before the installation is started, the installation program checks if there is sufficient free space
on the hard drive and returns an error message if this is not the case. If this occurs, a corres­
ponding amount of space must be freed up on the hard drive. All components required by the
Ottobock software are copied to the hard drive automatically by the installation program.

INFORMATION
The functioning of the PAULA 1.2 software in combination with 757M10 MyoBoy via a serial
connection is ensured with MyoBoy version 1.2 and higher. The version number of your MyoBoy
is engraved on the rear of the device in the housing below the nameplate.

http://ottoock.com/windows8
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7 Installation
Installation information
• Please note that observing the prescribed system requirements is mandatory.
• It is recommended that you do not run any other programs during installation and use of the

adjustment software, since this can affect performance.
• You must have administrator rights to install the software.
Carrying out the installation
To run the setup program, start Microsoft Windows and insert the software CD into the PC's
CD/DVD drive. The installation program starts automatically when the CD is inserted.

INFORMATION
If the installation does not start after the CD is inserted:
Windows 7/Windows 8: open "Computer" (key combination [Windows logo key  +E]).
Right-click on the CD drive in the right window. Click the menu item "Install or run program
from your media" with the left mouse button.

Windows 10: Press the key combination [Windows logo key  +E]. Right-click on the CD
drive in the left window. Click the menu item "Install or run program from your media" with the
left mouse button.

After the installation program starts, follow the on-screen instructions.
Information: fields marked with an asterisk (*) are mandatory.

7.1 Registration

INFORMATION
The product code required for registration is printed on the inside of the CD cover.

When the summary of the data already entered appears, the fol­
lowing possibilities (buttons) for requesting the licence number
are available:

Webmail available ("Copy to Clipboard" button)

If you do not use a standard e-mail program, but have access to
the Internet from your PC, carry out the following steps: 
1. Click the "Copy to Clipboard" button. 
2. Paste the contents of the clipboard into the text field of your

email client (e.g. Hotmail, Yahoo, ...) with the key combina­
tion [Ctrl+V] or with the right mouse button.
Information: automatic processing is only possible in
this way. If the contents of the clipboard are sent as a
separate file, the processing cannot be automated and
it will take longer to receive your licence number.

3. Send the e-mail to the following address:
registration.austria@ottobock.com
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Fax available ("Print" button)

If you do not have an Internet connection, carry out the follow­
ing steps:
1. Click the "Print" button to make a printed copy.
2. Send the printout by fax to the following address:

(+43-1) 526 79 85 • Otto Bock Healthcare Products
GmbH • Brehmstraße 16 • 1110 Vienna • Austria.

INFORMATION
The installation can only continue once you have received the licence number. Please ensure
you keep the licence and registration information in a safe place.

You will receive your personal licence number within the next 2 working days.

7.2 Continuing the Installation after Receiving the Licence Number
Enter the licence number in the "Licence number" field and
click the "Next" button. Follow the subsequent instructions from
the installation wizard.

Once installation is complete, an icon for starting the Ottobock
Data Station is added to the Windows desktop. The "PAULA
1.2" software can be accessed after the Ottobock Data Station
has been started.
The Ottobock Data Station is a superordinate software platform
used to launch the corresponding programs. For this reason a
separate icon for the "PAULA 1.2" software is not created dur­
ing installation.

8 Starting the Program

INFORMATION
To run the software, ensure that the user is logged on to the PC with at least standard user
rights.

• Double-click the  icon (Ottobock Data Station) on the
desktop. The program starts.

• After the Ottobock Data Station has been started the first
step is to create a new patient record (click the "Add
Patient" button) (item 1) or select an existing patient record
(item 2).
Information: fields marked with an asterisk (*) are man­
datory.

• Click the "Add Job" button (item 3).

► Click on the appropriate amputation level for the patient.
A window opens where different options for the new task can be selected.
A detailed description can be found in the online help of the Ottobock Data Station (see page 8). 
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INFORMATION
Fields highlighted in light blue indicate software applications that have not been installed yet.
Contact the Ottobock branch responsible for your country in order to ask about the availability of
these applications.

9 Closing the Program
The following options are available for closing the program:
• Click "File > Exit" in the menu bar
• Click the "X" button in the top right corner of the program window
• Press the key combination [Alt+F4]
• Select the Windows system menu and click "Close via Start Menu"

10 Uninstalling
To uninstall the Ottobock software, use the Windows uninstall function.
All components of the adjustment software are deleted during the uninstall. If another adjustment
software is installed within the Data Station, the Data Station remains, otherwise it is deleted as
well.
However, the entered patient data are not deleted.

11 Further Information
11.1 Information Regarding the Online Help
The online help can be accessed via the F1 button or the "Help > Contents ..." menu bar.

11.2 Obtaining Program Version Information
The current program version of the installed software can be obtained from the menu bar. You
should have this information available whenever you contact the software support.
1) Click "Help > About" in the menu bar.

→ A window with the currently installed software will open.
2) Click on the desired entry to obtain further information.

11.3 Software Updates
Software and driver updates will be made available for free at regular intervals.
1) Click "Help > Otto Bock Support Website" in the menu bar when you are connected to the

Internet.
→ The webpage for the "Data Station" software will open.

2) Search for the description of the software that is to be updated under "Application/Patch".
3) Search for the applicable version.
4) Click "Download" in the column on the right in order to download the update.
5) Extract the "ZIP file" and execute it.

12 Required tools
• 743R11 Case set 
• 743L234 Digital camera
• 99B90=2 Residual limb sock
• 743S50 Black photo background
• 743S30 Calibration tool
• 623Z20 Loop attachment points
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13 Process for creating patient photos

INFORMATION
If you wish to use the computer-aided socket design, you will need the 743R11 case set with the
743L234 digital camera.

To design a test socket using the software, digital photos of the patient's residual limb must be
taken.
Process for creating digital images
1. Preparing the patient
2. Taking patient measurements
3. Attaching the calibration tool
4. Setting up the camera
5. Taking patient photos
6. Transmitting the photos from the camera to the PC

13.1 Preparing the patient
► Pull the white 99B90=2 residual limb sock

over the residual limb as smoothly as pos­
sible. Flex and extend the residual limb as
much as is possible. The sock adjusts to
the residual limb. This reduces any shifting
during subsequent marking.
INFORMATION: At any rate, the sock
should not be pulled up too tight. This
would distort the contour of the resid­
ual limb and thus render the photos
useless. Any wrinkles, which may form
in the case of very small or pointed
residual limbs, can be touched up later
in the software.

13.2 Taking patient measurements
► Measure the widest ML measurement dir­

ectly on the condyles using the calliper
supplied. This measurement will have to be
adjusted for the patient for the subsequent
socket processing in the software by
adding approximately 10 mm.
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► Mark with an X the position of the lateral
electrode directly on the sock. The ML
measurement can be noted laterally on the
residual limb.
INFORMATION: The position of the
medial electrode does not have to be
marked; this is determined by a rule
(directly opposite of the lateral elec­
trode).

► Mark the position of the olecranon. Identify
the olecranon protrusion with a horizontal
line. The residual limb flexion must already
be 15 degrees; otherwise, this would
cause shifts in the bony protrusion below
the sock and skin. Make sure that the
markings are precise! The reference point
is used by the software to check the socket
length.
INFORMATION: The line towards the
lateral side of the residual limb must
be extended somewhat, so that it is
well visible in the lateral photo. In addi­
tion, stress and relief points can be
marked on the residual limb in order to
position a patch later on, for example.

► Attach the 743S50 black photo back­
ground to the patient. It has an opening for
the arm and can be attached easily to the
shoulder. When taking photos, all of the
white residual limb must be in front of the
black background.
INFORMATION: If necessary, use the
attachment belt supplied. This may be
particularly helpful with posterior pho­
tos. 
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13.3 Attaching the calibration tool
► Attach the 743S30 calibration tool posteri­

orly to the residual limb along the residual
limb's longitudinal axis. Use the 623Z20
loop attachment points for this purpose.
INFORMATION: Positioning in the case
of short residual limbs is possible
slightly above the olecranon (horizont­
al marking remains visible).

► The calibration tool must remain in the
exact same position on the residual limb in
both photos. If the calibration tool comes
loose or shifts after the first photo, it will
have to be re-attached, and both photos
will have to be retaken.

13.4 Setting up the camera
1. Maximum optical zoom (3x)
2. Turn off macro or wide angle
3. Resolution 1600x1200 ("M3" for the Canon IXUS 95

model)
4. Very fine compression 
5. Manual mode
6. Turn on flash, turn off redeye reduction

13.5 Taking patient photos
• A lateral-view and a posterior-view photo is required.
• Photograph the calibration tool with the residual limb orthogonally, so that only the white front

of the fins can be seen. Only two of the white reflector points may be visible!
• Ensure that the recommended residual limb flexion of 15° is maintained for the lateral and

posterior photo.
When creating the posterior photo, slightly set back the entire arm of the patient (shoulder rota­
tion). Re-adjust the 15-degree residual limb flexion and ensure that the residual limb is not rotated
(otherwise, pull down the arm a bit again). 
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Take the following steps to photograph the residual limb:

1) Keep residual limb rota­
tion neutral

2) Take photo at approxim­
ately 1 m from the residual
limb

Stumpf lateral Stumpf posterior

After taking the photos, check whether the specified residual limb flexion and appropriate number
of reflector points have been maintained.
TIP: Focus on the calibration tool with one eye and move your head until only the white front sides
of the fins are visible. Without moving your head, place the camera's viewfinder in front of your
eye and photograph the residual limb. 

13.6 Examples
CORRECT INCORRECT NOTES

Lateral image:
The camera was not ortho­
gonal to the residual limb.
The yellow colour of the
fins is visible!

Lateral image:
• The arm was flexed too

much at approximately
40 degrees. 15° flexion
is ideal.

• The camera was not
orthogonal to the resid­
ual limb.

• The zoom was not
used, or the distance
was > 1 m.

CORRECT INCORRECT NOTES
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Posterior image:
For posterior photos, the
15-degree flexion in the
elbow joint must be main­
tained at all times. Failure
to do so would change the
view of the contour.

Posterior image:
The camera is not above
and orthogonal to the cal­
ibration tool, but to its
side.
When the camera is posi­
tioned perfectly, only the
top reflectors of the calib­
ration tools are visible,
while the lateral ones are
not.

13.7 Transmitting the photos from the camera to the PC
After taking the photos, check the digital photos in the camera's display, select the best images
and transmit them to the PC.
Two options for transferring photos are available:
• Use a memory card reader to read the card
• Read the memory card using a USB interface cable
In both options, the images can be stored in a file folder using Windows Explorer and will then be
available to the program for the socket design.

14 Trademarks
All product names mentioned in this document are subject without restriction to the respective
applicable trademark laws and are the property of the respective owners.
All brands, trade names or company names may be registered trademarks and are the property of
the respective owners.
Should trademarks used in this document fail to be explicitly identified as such, this does not justi­
fy the conclusion that the denotation in question is free of third-party rights.
Microsoft, Outlook and Windows are registered trademarks of Microsoft Corporation.
Pentium, Intel and Intel Core are registered trademarks of Intel Corporation.

15 CE conformity
Otto Bock Healthcare Products GmbH hereby declares that the product is in compliance with
applicable European requirements for medical devices.
The full text of the regulations and requirements is available at the following Internet address:
http://www.ottobock.com/conformity

http://www.ottobock.com/conformity


14

16 Symbols Used
Manufacturer

Declaration of conformity according to the applicable European directives

Article number

17 Licence Agreement
Manufacturer: see back of this document
PLEASE READ THIS END USER LICENCE AGREEMENT ("TERMS OF USE" OR "LICENCE AGREEMENT")
CAREFULLY BEFORE YOU INSTALL OR USE THE OTTOBOCK SOFTWARE. BY INSTALLING OR USING THE
OTTOBOCK SOFTWARE, YOU ARE AGREEING TO THE TERMS AND CONDITIONS OF THIS TERMS OF USE.
DO NOT USE THE OTTOBOCK SOFTWARE UNLESS YOU AGREE TO THE TERMS AND CONDITIONS OF THIS
LICENCE AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENCE
AGREEMENT, YOU CAN RETURN THE OTTOBOCK SOFTWARE TO THE LOCATION WHERE YOU ACQUIRED
THE SOFTWARE. IF YOU ACQUIRED THE OTTOBOCK SOFTWARE JOINTLY AND IN CONJUNCTION WITH
HARDWARE, YOU CAN RETURN BOTH THE HARDWARE AND THE SOFTWARE.
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THESE TERMS OF USE, YOU ARE NOT
AUTHORISED TO INSTALL OR USE THE OTTOBOCK SOFTWARE.

1. Contractual partners and object of the agreement
1.1 By accepting these Terms of Use, you are entering into a contract between yourself and the named Ottobock com­
pany (hereinafter also “Ottobock”); however, if you are acting on behalf of a company when installing or using the
Ottobock software (e.g. as an employee of said company), the contract is concluded between the company and
Ottobock (in which case “you” refers to said company). In case of any doubt, you are a party to the contract.
1.2 The licence covers the Ottobock software, including any related documentation (referred to as “Ottobock
Software” below). The terms and conditions of this licence agreement also apply to any updates to the Ottobock soft­
ware that replace or amend the original software – where Ottobock provides them to you after the installation of the
Ottobock software – unless such an update is the object of a separate licence agreement. Any possible maintenance
of the Ottobock software or other Ottobock products is not covered by this agreement; a separate agreement is
required.
1.3 To the extent that the Ottobock software will be used to provide recommendations regarding patient fittings (e.g.
for certain adjustments to Ottobock products after taking customer measurements), please note that such suggestions
merely represent non-binding recommendations from Ottobock. While Ottobock will take reasonable steps to ensure
the suggestions are correct, it is not obliged to provide technically accurate recommendations. Accordingly, Ottobock
is not liable for possible technical errors in the recommendations except in the case of intent or gross negligence.
1.4 To the extent that training requirements are specified for the use of the Ottobock software, the software may only
be used by qualified personnel.

2. Licence
2.1 The Ottobock software is protected by national copyright laws in many countries and by international treaties.
Ottobock will prosecute any violation of the copyrights it holds. You are only granted the right to use the Ottobock soft­
ware to the extent required by law or expressly granted to you according to this licence agreement. Ottobock and/or its
licensor(s) expressly reserve all ownership and/or other rights to the Ottobock software, including all copyrights, pat­
ents, business and trade secrets, trademarks and other intellectual property rights.
2.2 By accepting these Terms of Use, you are granted the non-exclusive and non-transferable right for 15 years to use
the Ottobock software for your own purposes in accordance with its intended use, subject to any restrictions con­
tained in these Terms of Use. “Own purposes” refers solely to the purposes of the respective contractual partner. In
the case of medical supply companies or other companies that provide patient services related to Ottobock products
(e.g. prosthesis adjustments), “own purposes” in terms of this licence agreement are also the purposes of the respect­
ive patient who wants to use the Ottobock products in accordance with their intended use.
2.3 You do not have the right to modify, edit, translate, rearrange, or otherwise alter the Ottobock Software nor to
decompile, disassemble, or reverse engineer the Ottobock Software yourself or via third parties unless expressly per­
mitted to do so by law.
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2.4 The Ottobock Software may only be installed on a single computer unless a supplementary licence agreement is
concluded. Simultaneous installation on several computers, installation on a network which permits the software to be
used on more than one computer at one time, or making the software accessible to the public are all prohibited.
Installing the Ottobock Software on a different single computer requires prior removal of the software from the previ­
ous computer. For the purposes of this EULA, "computers" shall also be understood to mean those Ottobock
products using the software according to its intended function.

3. Sublicences, assignment
Issuing sublicences for the use of the Ottobock Software is prohibited. Renting, leasing, loaning, or otherwise tempor­
arily ceding the Ottobock software to a third party is also prohibited.
The permanent assignment of the usage rights granted to you is only possible when:
• the third party to whom the rights are to be assigned accepts the terms and conditions of this licence agreement,
• the entire Ottobock software, and not just parts thereof, is assigned, and
• you do not retain any copies of the Ottobock software, not even in the main memory or cache of your computer.

4. Liability
Ottobock is liable to you according to the provisions of the Product Liability Act; in case of intent or gross negligence;
for the loss of life, physical injury or the impairment of health; where Ottobock issues any guarantees; and in other
cases of mandatory legal liability – respectively pursuant to the applicable legal regulations. Damages shall be limited
to an amount representing typically foreseeable damages. Damage compensation claims against Ottobock in case of
slight negligence are excluded.
Any other claims for compensation by you against Ottobock – no matter on what legal grounds and especially due to
material defects, defective title and/or the breach of other obligations arising from the contract on the part of Ottobock,
its legal representatives, employees, or assistants or due to illegal acts – are excluded.
To the extent that the liability of Ottobock is limited or excluded by the preceding provisions, the same applies to the
personal liability of the legal representatives, employees or vicarious agents of Ottobock.
The preceding provisions do not affect the burden of proof to your detriment. Claims for compensation on your part
expire within the legal period of limitation, starting at the beginning of said period as established by law.
Ottobock is not liable for specific fitness or specific characteristics of the Ottobock software.
All claims shall be excluded if you fail to use and operate or modify the software expertly and properly and/or if you
combine or operate the software with unsuitable components.

5. Applicable law and jurisdiction
This licence agreement shall be subject to the laws of the country in which the manufacturer is domiciled. The UN con­
vention on contracts for the international sale of goods does not apply. The exclusive jurisdiction for all disputes arising
from or in relation to this licence agreement is the registered office of the manufacturer.

6. Severability clause
Should one or more provisions of this agreement be or become ineffective or unenforceable in whole or in part, the
validity of the remaining provisions of the agreement shall not be affected.
Any arrangement, change or addition (particularly commitments with respect to characteristics, features or the quality
of the software product) in connection with these Terms of Use shall be deemed void unless made in writing and
unless Ottobock’s prior consent has been obtained.
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